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Introduction

Thank you for purchasing the Tbyone Belt Drive Turntable System. This instruction
manual contains important information about its safety, usage and disposal. Use
the product as described and keep this manual for future reference. If you sell this
turntable or pass it on, please also give this manual to the new owner.

Safety Instructions

Read and understand this entire manual before using this product. Keep these
instructions for future reference.

1. Do not use the turntable near water.

2.Only connect the turntable to a power outlet type as indicated on the marking
label or in the "Specifications" section of this instruction manual.

3.The turntable has a polarized plug (one pin is wider than the other). To reduce the
risk of electric shock, this plug is intended to fit into a polarized outlet in only one
orientation. If the plug does not fit fully into the outlet, reverse the plug. If it still
does not fit, contact a qualified electrician. Do not attempt to modify the plug in
any way.

4. Protect the power cord from being walked on or pinched, particularly at the power
plug, at the point of connection between the plug and outlet and at the point of
connection between the power cable and speaker.

5. Do not overload wall outlets or extension cords as this will be a fire hazard and may
cause electric shock.

6. Never push objects of any kind into the turntable through openings as they may
touch dangerous voltage points or short out parts that could result in a fire or
electric shock. Never spill liquid of any kind on the product.

7. Do not attempt to service the turntable yourself as opening or removing body
panels may expose you to dangerous voltage or other hazards. Refer all servicing to
qualified service personnel.

8. Changes or modifications to the turntable not expressly approved by the party
responsible for compliance could void the user’s authority to operate the product.

9. Do not use attachments not recommended by the manufacturer as they may cause

hazards.

10. Only place on aflat, sturdy table or use with the cart, stand, tripod or
bracket as specified by the manufacturer or sold with the turntable.
When a cart is used, use caution when moving the cart/turntable
combination to avoid injury from tip-over. -



11. Slots and openings in the cabinet are provided for ventilation and to ensure
reliable operation of the product and to protect it from overheating. Do not block
or cover these openings.

12. Unplug the product during lightning storms-or when unused for long periods of
time.

COMPLIANCE WITH FCC REGULATIONS

This device complies with Part 15 of FCC rules. Operation is subject to the following
two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

WARNING: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

WARNING: Cancer and Reproductive Harm - http://www.P65Warnings.ca.gov
For more information go to http://www.1byonebros.com/Compliance/Prop65

Product Description

1. Counterweight .

2. Anti-skating Stick

3. Turntable Platter

4. Tonearm Lift Lever
5.Tonearm Rest & Clip
6.33/45 RPM Selector
7. Tonearm

8. Stop/Start Dial

9. Cartridge
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10. Lid

11. Lid Hinge

12. Ground Connector

13. PHONO & Line Out Jacks
14. PHONO & Line Out Switch

15. Anti-skating Weight
16. USB-PC Port

17. AC-DC Power Jack
18. Bluetooth Indicator
19. Power Switch

Upon opening the turntable’s package, locate all of the following included items.

1) Turntable Unit

2) Power Adapter

3) Lid

4) Counterweight

5) Anti-skating Weight
6) Platter with Belt

7) 45 RPM Adaptor

8) Slip Mat

9) Cartridge Alignment Protractor
0) USB-PC Cable

1) Belt Hook
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This turntable is supplied with a factory-fitted cartridge that's already adjusted.

Note: Instructions provided in this manual for adjusting the cartridge are provided in
case the cartridge is replaced at a later date by a different model.

Installing the turntable
- Mount the turntable on a level surface.

- To avoid the effects of vibrations and acoustic pressure, do not mount the turntable
next to items such as speakers.

- The turntable may pick up radio static if placed next to a radio. Therefore, try to keep
the turntable away from transmission devices such as radios.

- If the turntable is near equipment (cell phone, etc.) that emits strong radio waves,
noise may occur.
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Turntable Platter and Belt Setup

1.Turn the platter over and check the belt position.

Make sure that the drive belt is looped in the middle of the circle. The drive belt
located too high or too low in this circle may cause the drive belt to fall off or speed
to be unstable.

2. Set the platter on the spindle.
« Make sure that the platter is fully seated on the spindle.

Opening Platter

Motorpulleyﬁﬂ‘j’L l
=
Spindle —————

3. Place the belt on the motor pulley.

- Align one of the platter openings with the motor pulley, and, while pulling both
ends of the red ribbon that comes attached to the belt, place the belt on the
motor pulley, as per the diagram. When doing this, be careful not to twist the belt.

Ribbon

Motor Pulley

Straight Twisted Wrong location

4. Remove the red ribbon from the belt.



Rotating the Platter

1. Using your hands, slowly rotate ‘
the platter ten times in a clockwise Rl | on
direction (Figure 1).

2. This step is for resetting the auto
mechanism, getting rid of any twists in
the belt and making sure the belt rides
smoothly along the drive rim on the
underside of the platter.

3. Place the slip mat on top of the platter. Figure 2 Sli
mat
Make sure the 1byone logo on the mat @ Ip
is facing up (Figure 2).

Cartridge Tracking Force Adjustment

The supplied Counterweight is suitable for cartridges weighing between 3.0-6.0g.

1. Gently push and turn the Counterweight onto the N Counterweight
rear of the tonearm (with the dial facing towards the il Tracking Force Dial
front of the turntable). |

V.

2. Pull the protector straight forward to remove it.
Note: Applying a downward force may cause the stylus

to come off the body. Only low volume is output if the CAREFUL !
stylus has come off, or is about to come off, so refer to
“Replacing the stylus"to reattach the stylus correctly. @3

3. Remove the tie-wrap and unlock the tone arm.

4. Lower the tonearm lift and position the cartridge in the space between the tonearm
rest and platter.

5. Carefully rotate the Counterweight until the tonearm achieves a neutral, level
balance. The tonearm should return to this balanced position if it is moved up or
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down. Perform this adjustment carefully.

Counterweight Tonearm

T ]

6. Once the tonearm is correctly balanced, return the tonearm to its rest. Without
moving the metal counterweight, gently rotate the tracking force dial to align
the "0" with the black center line. Check to make sure the tonearm is still neutrally
balanced.

Counterweight

Tracking Force Dial

N (Center Line

7. Finally, hold the rear of the counterweight and rotate it counterclockwise(as seen
from the front) to adjust the tracking force according to the cartridge manufacturer's
recommended 3.5g.

Note: Take care and do not touch the tracking force dial during adjusting the
tracking force.

Note: Each mark on the dial represents 0.05g. The recommended tracking force for
the factory-installed cartridge is 3.5g+0.5g. It only goes up to 2g for one rotation of
the tracking force dial, meaning you will need to make the second rotation and
stop at "1.5" to reach 3.5g.




Anti-skating Force Adjustment

The anti-skating force must be adjusted corresponding to the tracking force as follows:

Tracking Force Groove in the stub

5-10 mN Tst from bearing ring
10-15 mN 2nd from the bearing ring
15-20mN 3rd from the bearing ring @0 20

20mN and larger 4th from the bearing ring

1. Slip the loop of the anti-skating weight's thread over the 3rd groove of the stick to
set the correct anti-skating force for the factory-fitted cartridge.

Installing the Lid

Install the Lid carefully over the hinge prongs.

Setting Phono-Line Out Switch

This product has a built-in phono equalizer function. You can use the turntable, even
if you do not have a phono amplifier or connectable equipment with a built-in phono
amplifier.

Use the Phono-Line Out Switch to set the output, as shown below.

Connectable device being used Position of Phono-Line Out Switch
Device with phono input Phono
Device without phono input Line

Connection to an Amplifier (Device with Phono input, PHONO mode)
This turntable uses a moving magnetic cartridge. Set the PHONO & Line Out Switch
on PHONO mode. Connect the phono out cables to the phono input on your amplifier
of pre-amplifier (phono stage). Line inputs such as CD, Tuner, Tape, or Video are
not suitable for phono inputs. Make sure the amplification of the selected input
matches the type of cartridge being used. The factory installed cartridge is 47k ohms /
MM-input.
NOTE: If your amplifier does not have an input suitable for phono cartridges, you
will need to purchase a separate phono amplifier for moving magnetic cartridges.
This separate phono amplifier will then connect between your turntable and your
amplifier.

Stereo System Connection (Device without phono input, LINE mode)

Set the PHONO & Line Out Switch to LINE mode. The RCA PHONO & Line Out
Jacks output analog line-level signals and can be connected directly with a pair of
active/powered speakers of the appropriate input of your stereo system.

The Red plug connects with the Right channel and the White plug connects
with the Left channel.

NOTE: The RCA Jacks are not designed to be connected directly to passive/

unpowered speakers in LINE mode. If connected to the passive speakers, no sound
will come out.

Main Power Connection

Unpack the power adapter from the foam packing material and plug the small end
into the DC power jack located on the back of the turntable. Plug the power adapter
plug into an electrical outlet.




Power Management Function

The turntable will automatically go into standby mode after 20. minutes of inactivity.

To resume operation, simply press the power switch off, then press it to the "ON"
position after 1 second.

Turntable Operation
1. After connecting to power, press the power switch to the “ON" position.
2.Remove the stylus protector from the stylus.

3. Place the slip mat on the platter and place a record on the slip =
mat. If using 45 RPM records, put the 45 RPM adapter on the center “
spindle before placing the record on the platter. <

4. Set the 33/45 RPM Selector according to the type of record. 45RPM Adapter

5.Turn the Start/Stop dial to the Start position. The platter will start spinning.

6. Unlock the tonearm clip and set the Lift Lever to the up position.

7. Position the tonearm over the desired location (groove) on the record.

8. Move the tonearm lift lever to the down position to move the tonearm toward the
record. Alternatively, place the needle over the desired location on the record.

9. Carefully lower the tonearm on the record.

10. When you are finished playing the record, raise the tonearm, return it to rest on the
arm clip, and turn the Start/Stop dial to the Stop.

Bluetooth Operation

This turntable has a Bluetooth transmitter to wirelessly send audio to a Bluetooth
speaker.

1. Power on your Bluetooth speaker and ensure it is in pairing mode.

2. Power on the turntable. BT will auto search when the turntable turns on and the BT
LED indicator light will flash.

3. When pairing, the light will flash twice per second and will become solid when
paired successfully.

4.To disconnect pairing, power off the turntable or turn off Bluetooth pairing on your
Bluetooth speaker.

5.This turntable will connect to the nearest Bluetooth speaker. If after 2 minutes no
Bluetooth speaker can be found to pair with, the Bluetooth transmitter will become
inactive and the LED will turn off. If you need to connect again, power off the turntable
and the speaker then power on again.

Bluetooth Indicator Bluetooth Stauts
Flash Auto searching and pairing
Solid Paired successfully
Off Inactive
NOTE:

1.The initial connection may take longer, usually between 30 to 80 seconds. After a
successful connection, the subsequent connection time will be shortened to 10
seconds. Please be patient and wait.

2.The Stop/Start Dial can only control the operation of the platter. To control music
streaming through Bluetooth, please use the control panel of your media
device.

Recording the Vinyl to Your Computer

Please follow the below steps to set up Audacity to record from the USB audio device.
For more details, please refer to the BRIEF INTRODUCTION OF AUDACITY at https://
manual.audacityteam.org/man/recording_with_usb_turntables.html

1. Download the Audacity software and complete installation
1.1 Ensure your Audacity software is up to date. You can download the current
version from http://www.audacityteam.org/download/

1.2 Follow the instructions to complete installation.

2. Set up Audacity to record from the USB audio device.
2.1 Connect the USB device

Use the supplied USB cable to connect your turntable and your computer. No
extra driver is required.

2.2 System settings needed for Windows and Mac
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Windows:

1. By the system clock, right-click over the Speaker icon select Sounds then
the Recording tab, and then click on the USB device in the list and click
Properties. Click the Advanced tab set your required bit rate and sample rate

2.0n the Advanced tab, in the "Default Format" section, make sure the
dropdown menu is set to "2 channel 16-bit 44100 Hz".

not work for your version of Windows), see Windows: accessing the Windows
Sound controls.

Mac:

1. From Apple Menu > System Preferences select "Sound" and click on the /nput
tab

2. Select "USB Audio CODEC" or similar as the input device and verify the
Recording Meter shows input.

3. If the recording meter in the Sound preferences panel does not show input:
1. From the Finder, select Go > Utilities and open Audio MIDI Setup.

2.1f the Audlio Devices window is not visible, select Window > Show Audio
Devices.

3. Select your USB input device in the list in the left pane of the Audio Devices
window.

4. Set the Format to "44100.0 Hz" and "2ch-16bit".

For a more detailed walk-through of the above steps for Mac, see Mac and USB
input devices on the Audacity Wiki.

from the Default Format dropdown (normally "2 channel 16-bit 44100 Hz").

For a more detailed walk-through of the above steps for Windows (or if that does

2.3 Launch Audacity.

If Audacity is already running when you connected the cable, choose Transport
>Rescan Audio Devices or restart Audacity.

2.4 Project Rate

Set the Audacity Project Rate in Selection Toolbar at the bottom left of the
Audacity screen to 44100 Hz:

Project Rate (Hz). | Snap-To Audio Position Start and End of Selection ~
of  ~||[00h00m00.000s~ |[00R00mO00.000s" [00R00MO0.000s~
2.5 Devices

Use Device Toolbar to set the recording and playback devices and to set the
recording channels to "2 (Stereo) Recording Channels', as in the below example on
Windows 10:___

MIME v 4 Analog Connector (UA-1EX) ~ 2 (Sterec) Recorc ~ W)} | Speakers
- g9 p
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- The Recording Device is set to the USB device (in this case the device name, but

often called or including the phrase "USB Audio CODEC").

- Recording Channels is set to stereo.
- The Playback Device is set to the named speakers of the built-in computer sound

device.

- These settings can also be changed in Devices Preferences.

Windows calls most USB external devices "microphones”. Some higher-end USB
recording interfaces may appear as their explicit manufacturer's name.

3. Software Playthrough

Use Transport > Transport Options > Software Playthrough (on/off) and click
"Software Playthrough" to turn it "on" (the checkmark is shown when it is "on").
This setting can also be enabled or disabled in Recording Preferences. Software
Playthrough lets you hear the turntable through the computer speakers when
recording. It also lets you hear the turntable without recording if you turn on
monitoring (see the next section below).

4. Monitoring
Enable monitoring to set the recording level
- Turn monitoring on by clicking once on the microphone icon in the Recording

Meter.

0 0 0 [ 0 0 0 [ 0 0 0 [ 0 0 0 [ o o o [
\!JF‘. -3 -54 -51 48 4542 -39 -36 -33 -30 -7 24 21 18 -15-12 -5 6 -IIEI- 'DA

- In Mixer Toolbar, turn up the left-hand playback volume slider (by the speaker icon).

“.r)— ﬁ +‘Di +

« The right-hand recording volume slider (by the microphone icon) can often be used

to vary the loudness of the recording, but it may not function with all turntables.
If it does not, try adjusting the output level on the turntable (often, there is a gain
control under the chassis).

Alternatively, you may be able to adjust the input level on Windows and Linux only,
usually by looking for the speaker icon by the system clock. On Windows, right-
click over the speaker icon > "Recording Devices" Then right-click over USB
Audio Codec, choose "Properties" and click the Levels tab.

» Try to aim for a maximum peak of around —6 dB, which corresponds to

around 0.5 on the waveform. You can always boost the level later with Effect
> Amplify... or Effect > Normalize... after you have completed editing.
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5. Recording

Then, ignoring any instructions in the manufacturer's guide to select "stereo mix'’,
simply press the Record button @ in Transport Toolbar to start recording from the
turntable.

6. Recording, editing and exporting

Once your USB turntable is set up and working properly, go to the Basic Recording,
Editing and Exporting section of Audacity’s Tutorial - Copying tapes, LPs or
MiniDiscs to CD for instructions on how to:

- make and edit your recording

- export it to an audio file

« import it to iTunes or Windows Media Player
« burnittoCD

Audacity’s reference links:

- Basic Recording, Editing and Exporting : https://manual.audacityteam.org/man/
basic_recording_editing_and_exporting.html

- Tutorial - Copying tapes, LPs or MiniDiscs to CD : https.//manual.audacityteam.
org/man/tutorial_copying_tapes_Ips_or_minidiscs_to_cd.html

Maintenance and Cleaning

NOTE: Disconnect the power cable plug from the outlet as a precaution before ‘
maintenance.

Turntable Body

Your turntable requires little of no regular maintenance. Remove dust with a slightly
damp antistatic cloth; never use a dry cloth as this will create static electricity and
attract more dust! Antistatic cleaning agents are available at specialist stores, but must
be applied sparingly to avoid damage to rubber parts. It is recommended to install the
needle cover before cleaning or maintenance is carried out to avoid damage.

If the turntable is not used over a long period of time, the drive belt should be
removed to prevent unequal stretching.

NOTE: Always disconnect the record player from the power supply as a precaution
before maintenancel!

Useful Tips
The turntable should be positioned on a low-resonance surface such as wood or
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multiple layer ply board to avoid structural vibrations disturbing playback.

Stylus Tip O X

- If dirt and grime are stuck to the stylus tip, clean it
with a commercially-sold brush.

- We recommend using a stylus cleaner (not
included) if the stylus tip is considerably dirty. S —
Clean the stylus tip by moving the brush from the ﬁ ﬁ
rear to the front of the stylus tip.

Replacing the Stylus

Removing the Stylus
- In addition to the deterioration of sound quality, records may also be damaged as
the cartridge’s stylus tip wears down.

« As arule of thumb, replace the stylus after 300 to 500

hours of use. WEE?%
- Be sure to disconnect the product’s power cable plug
from the outlet.
1. Remove the protector from the cartridge. )

2. Remove the stylus by pulling in the direction of the arrow.

Installing a New Replacement Stylus
1. Grasp both sides of the stylus holder and insert the stylus grip into the rear tab of
the cartridge.

Stylus holder @
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Replacing the Belt 4.Turn the platter over and you will see a raised circle. Loop the new belt

« The beltis a consumable part. Replace the belt if the speed of playback slows down along the middle clrcle.
orirregular rotation occurs. As a rule of thumb, we suggest replacing the belt
once a year.

- Before replacing the belt, be sure to disconnect the product’s AC adapter from the
outlet.

1. Remove the slip mat.

5. Attach the platter.
Align one of the openings with the position of the brass-colored motor pulley.

6. Place the belt on the brass-colored motor pulley.

Grasp the belt that was attached in step 4 and, while pulling it, place it on the
brass motor pulley.

J
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7. Using your hands, slowly rotate the platter ten times in a clockwise
direction as shown by the arrow below.

10X

Cartridge Replacement

1. Before replacement, put the stylus protector back on the stylus to prevent damage
to the stylus during the replacement process.

2. Carefully remove the wire leads from the original cartridge.

3. Loosen the two screws on the headshell that are securing the cartridge and then
remove the original cartridge.

4. Mount the new cartridge to the headshell and tighten it lightly. Do not completely
tighten the screws at this moment.

5. Connect the wire leads to the new cartridge’s terminals .The wire lead color codes
are as below:

Wire Channel

White Left channel positive (L+)
Black Left channel negative (L-)
Red Right channel positive (R+)
Black Right channel negative (R-)

6. Adjust the cartridge’s position to make sure it is precisely aligned on the headshell
so that the stylus will be tracking the grooves in parallel perfectly.

To achieve this, place the included paper cartridge alignment protractor over
the turntable spindle, carefully lift the tone arm and place the tip of the stylus on the
points marked 130mm and 250mm respectively. Fine tune the cartridge’s position
on the headshell until the cartridge is perfectly in parallel with the reference lines at
both points.

7. Tighten the screws completely once the perfect alignment is achieved.

NOTE: If you are unfamiliar or uncomfortable with completing this procedure, we
recommend consulting with a professional to perform the installation.
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When the Turntable is Moved

Using the product's original packing materials, wrap the turntable in the reverse order
from when you unwrapped it. If you do not have the packaging materials, take the
following measures:

- After disconnecting the AC adapter from the outlet, remove the felt mat and platter,
and then wrap them so that they do not get damaged.

- Attach the protector to the cartridge.

- Use a string or something similar to tie the tonearm to the rest so that it does not
become dislodged.

- Wrap the turntable body with paper or a soft cloth so that it does not get damaged.

Technical Specifications

Turntable

Model 1-AD07US01,H005 Speed Variance +1.5%
Nominal Speeds 33 1/3 & 45RPM Wow and Flutter <0.15%
Effective Tonearm Length |8.6"(218.5mm) Signal to Noise 55dB
Tracking Force Range 3.0-6.0g Overhang 0.73in
Outboard Power Supply  [12V/ 500mA AC-DC Power Consumption [5W

AC Power Adapter Input: 100-240V 50/60Hz, Max. 200mA
Dimensions (W x H x D) 16.34"x 10.2"x 444" (415 x 340 x 148mm)
Weight 13.67Ibs (6.2kq)

Cartridge

Stylus Model Audio Technica AT-3600L
Frequency Response 20Hz-20kHz
Recommended Load Resistance 47kohms

Channel Balance < 2.5dB

Amplifier Connection MM -input

Channel Separation > 18dB

Recommended Tracking Force 3.540.5g

Output Voltage 2.5mV

Weight 59




Potential Incorrect Use and Fault Conditions

This turntable is manufactured to the highest standards and undergoes strict quality
controls before leaving the factory. Faults that may possibly occur are not necessarily
due to material or production faults but can sometimes be caused by incorrect use or
unfortunate circumstances. Therefore the following list of common fault symptoms
has been included here.

There is no power:
- The turntable is not connected to the power adapter.

- No power at the outlet.

The platter doesn’t turn although the unit is switched on:
- The unit is not connected to the main power supply.

- No power at the outlet.
- Drive belt is not installed or has slipped off.

No signal through one or both channels:
- Phono input not selected on amplifier.

- Ampilifier not switched on.

- Ampilifier or speakers muted.

- No connection to the speakers.

- No connection between turntable and amplifier.
- Wire leads not connected the cartridge.

Strong hum on phono input:
- No ground connection from cartridge, arm, or arm cable to amplifier or ground loop.

- Turntable is too close to speakers.

Distorted or inconsistent sound from one or both channels:
- Turntable is connected to wrong input of the ampilifier.

- Needle or cantilever damaged.

- Drive belt overstretched or dirty.

- Platter bearing without oil, dirty or damaged.

- Dust on stylus.

- MM / MC switch on pre-amplifier set incorrectly.
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Does the arm automatically go onto the record to play and vise versa?
- The turntable is not automatic, so you should manually put the tonearm onto the
record or put it back.

Cannot connect to the Bluetooth speaker:
- The turntable is not powered on.

- The Bluetooth transmitter has turned off because Bluetooth is not connected in 2
minutes.

- Your Bluetooth speaker is not in pairing mode.

- When connecting Bluetooth for the first time, please reset the Bluetooth speaker
or Bluetooth headphones that you want to connect and clear all Bluetooth pairing
records.

- Please turn off other devices' Bluetooth function except for the Bluetooth speaker
or Bluetooth headphones you want to connect(including the Bluetooth on your
phone).

- The initial connection may take longer, usually between 30 to 80 seconds. After
a successful connection, the subsequent connection time will be shortened to
10 seconds. But due to differences in Bluetooth protocols among various brands
and models of speakers or headphones, the connection time may sometimes be
extended. Please be patient and wait.

- Due to differences in Bluetooth protocols among various brands and models of
speakers or headphones, there may be cases where the Bluetooth connection is
unsuccessful.

Needle isn't touching the record:
- The screw on the tonearm rest may have loosened during transport. Gently turn this
screw clockwise to move the needle stylus closer to the record.

Needle is scratching the record's surface:

- Gently turn the tonearm rest screw anticlockwise to move the needle stylus away
from the turntable.

NOTE: Factory screw tightness is based on the thickness of the included slip mat.
If a thinner or thicker 3rd-party slip mat is used, gently adjust the screw as needed
following the steps in the last two situations.

@ This product’s packaging is made from environmentally friendly material
%Q and can be disposed of at your local recycling plant.
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Customer Service

Phone: +1 909-391-3 888 (Mon-Fri 9:00am - 5:00pm PST)
Email: ushelp@1byonebros.com

UNITED STATES

CANADA Email: cahelp@1byonebros.com

UNITED KINGDOM | Email: ukhelp@1byonebros.com

GERMANY/FRANCE

ITALY/SPAIN Email: euhelp@1byonebros.com

BRAND OWNER
Tbyone Products Inc.

1230 E Belmont Street, Ontario, CA, USA 91761
Customer Service: +1 909-391-3888
www.Tbyonebros.com
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